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Section 1: Introduction 

Congratulations on purchasing the profiler instrument. 

The profiler instrument and associated PRTC module caters for: 

• Commutator and slip ring surface profiling 

• Temperature -10 °C to 1000 °C (14 to 1830) °F with optional 
K type thermocouple 

• Current measurement up to 1000 Amperes DC with optional 
current probe 

Collected data can be transferred to a PC where it can be analyzed 
in detail using the MAS Windows-based software supplied in the kit. 
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Standard Features 

• 24-bit A/D converter providing high-precision measurements 

• 512 KB non-volatile memory capable of storing up to 400 
000 sample points 

• Time and date stamped recordings 

• Temperature compensated graphical LCD (liquid-crystal 
display) with 240 x 128 pixels 

• Electro-luminescent LCD backlight 

• Built-in battery charger and conditioner 

• 1500 mAh Ni-Cad (Nickel-Cadmium) battery pack 

• Upgradable firmware 

• RS232 interface to communicate with a PC 

• Windows-based MAS analysis software 

• Time and date stamped recordings 

 

Standard Kit Items 

• Profiler instrument 

• Sensor complete with clamp and sleeve 

• Power adapter 

• Felt pen 

• Flashlight 

• G Clamp 

• Sensor spacer set 

• Download cable 

• Printer cable 

• DPU-414-30B serial interface printer 

• Printer power adapter 

• Profiler MAS software 

• Instrument and Software Guide 
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Summary of Parts 
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Precautions 

Please read and understand this section before operating your 
instrument. Heed all warnings and recommendations to prevent 
data loss, data inaccuracy, damage to the instrument, or injury 
to yourself. 
 

 

To avoid electrical shock, do not attach any sensor to 
a high voltage i.e. a voltage that exceeds 50 V DC or 
32 V AC or the ‘safety extra low voltage’ (SELV) 
defined by your local power authority. 

Ensure the cables and bootstrap cannot become 
entangled with any rotating or moving machinery. 

 

Do not operate the instrument in an explosive 
environment. 

 

Charge the battery pack up to at least 30% capacity 
before taking a recording. If using the instrument for 4 
hours or more, first ensure that the battery pack is 
fully charged.  

Constantly charging the battery when it is not fully 
drained will create a 'Memory' effect and eventually 
shorten the amount of charge that the battery can 
hold. 

Do not detach the battery pack from the instrument for 
more than 2 hours as data and settings may be lost 
from the instrument. 

 

Transfer data stored in the instrument to a PC before 

reprogramming the instrument. PROFLASHING the 

instrument with new firmware may erase all data 
stored in the instrument. 
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Do not expose the instrument to heavy impacts or 
pressure. 

 

To clean the instrument use a mild detergent diluted in 
warm water. Do not use abrasive or polishing 
substances, hydrocarbons, petrochemicals or solvents 
as they degrade the plastic. 

 

Do not place the instrument in a hot place where the 
temperature exceeds 140 °F (60 °C). Otherwise, the 
battery pack will degrade. 

 

Although the instrument has a rugged construction, do 
not expose it to wet conditions or store it in a damp 
place where the relative humidity exceeds 95%. 

 

Ensure that the battery pack is securely fastened (but 
not over-tightened) to the instrument before operating. 

 

If the instrument malfunctions, return it to an 
authorized dealer. Do not attempt to repair the 
instrument yourself as this will invalidate the warranty. 

 

Use only an approved instrument power transformer 
13.5 V ± 1.5 V DC, 1 A output, center positive, and 
ensure its voltage and frequency rating matches that 
of your mains AC power. 
 

 

Never mount the commutator sensor in a live motor. 

When the profiler instrument is connected to a PC via 
the RS232 cable, its negative internal supply is 
connected to ground. The thermocouple may then be 
used only on surfaces isolated from ground. 
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Recommendations 

• Use the Peak height option for general commutator and slip 
ring maintenance. 

• Use the Shape option for commutator and slip ring 
measurement only when the measurements are to be 
downloaded to a PC using the MAS software. 

• Print the Bar shape only when necessary. Printing Bar shape 
on the thermal printer takes a considerable amount of time 
due to the extra data required. 

• The sensor has been constructed to withstand normal 
handling. To avoid damage, the sensor head, wheels and 
support assemblies must still be treated with care at all 
times. 

 

Guidelines for Commutator Testing 
The profiler instrument has a significant advantage over Dial 
Indicators for commutator testing. In addition to TIR readings the 
instrument can also produce Bar-to-Bar deviation readings and high 
mica detection (insufficient mica undercut depth). This enables you 
to diagnose the condition of the commutator or slip ring. 
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Interpreting Profiles 

The following information is based on recommendations for 
commutator condition provided courtesy of: 

National Electrical Carbon Products Inc. 
Greenville, South Carolina 
USA 

 

Situation 

 

Runout 

( TIR ) 

Bar-to-Bar 

Variance 

Undercut Depth 

 

New 

 

Less than 

1.5 mil or 40 µm 

 

Less than 

0.2 mil or 5 µm 

 

Greater than 

50 mil or 1.25 mm 

 

In 

Service 

 

Less than 

3 mil or 75 µm 

 

Less than 

0.3 mil or 7.5 µm 

 

Greater than 

20 mil or 0.5 mm 

 

Needs 

Repair 

 

Greater than 

3 mil or 75 µm 

 

Greater than 

0.3 mil or 7.5 µm 

 

Less than 

10 mil or 0.25 mm 

 
Note: 'mil' is the US term for one thousandth of an inch. 
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A Good Commutator Profile 

The following is an example of a good profile recording. 

 

This recording passes all of the required specifications for a 
commutator that is in service. This recording has a Total Indicated 
Runout of 2.17 mil and a maximum Bar-to-Bar runout of 0.24 mil. 

 

A Bad Commutator Profile 

The following is an example of a bad profile recording. 

 

 

This recording fails both the Total Indicated Runout, and Bar-to-Bar 
specifications for a commutator that is in service. Its TIR value of 
3.15 mil is only just outside the specifications; however, the 
maximum Bar-to-Bar height difference of 0.98 mil is three times the 
recommended limit. During service you are likely to see visible 
sparking at the brushes and also hear brush clatter. 
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Section 2: Basic Operation 

This section describes the procedures for performing basic 
operations on your instrument. 

You will learn to: 

• Use the instrument menu system 

• Set up measurements 

• Measure data without saving it 

• Record data 

• Review recorded data 

• Change the recording and data display options 

Warning: Read the previous sections Precautions (page 10) and 
Recommendations (page 12) before operating your instrument. 
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Powering Up 

• Press the  key to power up the instrument. The 
Initialization screen is displayed. 

• Press  to display the Main Menu. 

• To power down press  and follow the on-screen 
instructions. 

 

Accessing the Main Menu 

• The Main Menu can be accessed at any time from any 

screen by pressing the  key. You may need to press this 
key more than once to return to the Main Menu. 

 

Selecting an Option 

• Press the numbered key that corresponds to the option you 
want to select. 

Example: 

• To select the New Recording option, from the Main Menu 

press  

 

The New Recording Menu shows the options available for taking a 
recording. 
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In some screens you may need to press  or  to highlight an 

option then press  to select the option. 

Example: 

• To select a Data Set press  Data Set. 

• Use the  or  keys to highlight a Data Set then press 

 to select it. 

 

• To return to the Main Menu press  

 

Editing Data Set ID's 

• To enter characters in the Edit Name window select New 

Recording from the Main Menu then select  ID to edit the 
Data Set name. 

• To clear the 'Unnamed Data Set' name press   

• Repeatedly press the key with the character you want until it 
appears above the flashing cursor. 
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Example: 
To enter the word BED 

• Press  three times until the 'B' is displayed. The cursor 
advances automatically when you press the next key. 

 

• To enter the letter 'E' press  three times until the 'E' is 
displayed. 

 

• If the next letter of the word is on the same key just pressed, 

press   to advance the cursor position e.g. press  

 then press key  until the letter 'D' appears. (The 

cursor can be moved backwards by pressing  ). 

 

Note:  and  can be used to enter the space character. 

You can open a list of all the Data Set names in memory. This allows 
you to easily name Data Sets that have similar names by selecting 
the closest match from the list then editing the appropriate 
characters. 

• Press   to display the list. 
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• Use  and  to select a name from the list. 

 

• Pressing  will change the currently selected letter to 
lowercase if it is currently uppercase. Otherwise it will 
change to the previous letter in the alphabet in uppercase. 

• Pressing  will change the currently selected letter to 
uppercase if it is currently lowercase. Otherwise it will 
change to the next letter in the alphabet in lowercase. 

• Pressing  when the currently selected character is a 
space will cycle through the various symbols that can be 
used then begin cycling through numbers. 

Note: If you cycle through to the letters it is not possible to use  

or  to get back to any symbol characters. 
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Short Cut Keys for Editing 
 

 
Cancel the edit screen and retain the original name 

  
Clear all text 

  
Move cursor forward 

  
Move cursor back 

  
Insert a space 

  
Delete a character 

  
Enter a space at the cursor position 

  
List the Data Set names in memory 
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Total Indicated Runout (TIR) 
The Total Indicated Runout for commutator and slip ring tests is the 
difference between the minimum bar (or segment) height and the 
maximum bar height. The TIR is also refered to as 'out of roundness'. 

 

Maximum Bar-to-Bar Height (MBTB) 
The Maximum Bar-to-Bar Height for commutator and slip ring tests is 
the maximum height difference between two consecutive bars (or 
segments). 

 

High Micas for Commutator Tests 
High Micas occur when there appears to be no gap between two 
consecutive bars. High Micas will be indicated as a bar number in 
the Edit Recordings window. 
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Setting up a Measurement 
The instrument is capable of performing measurements in: 

• Displacement 

• Temperature 

• Current 

 

Measurement Setup Menu 

Before taking a measurement you need to specify a sensor type so 
that the instrument knows what type of measurement to take. 

• From the Main Menu select  Measurement Setup. The 
Measurement Setup menu changes depending upon the 
sensor that is selected. 

 

• Press  Sensor to cycle through the available sensors for 
the instrument. 

There are three possible sensor types that can be used with the 
PRTC module: 

Temperature 
Current 
Displacement 

• Once the Sensor, Type, and Mode have been adjusted 

accordingly (as described in the following pages) press  
to display the Measure Without Recording Menu. This menu 
will allow you to make other setup adjustments before 
performing an actual recording. 
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Temperature Sensor 

There are no options that can be changed when using the 
Temperature sensor type. You must use a type K thermocouple for 
measuring temperature. 

 

 

Current Sensor 

When using the Current sensor type you can select the Input Range 
and the Scale. 

 

Input Range 

• Press  to cycle through the three input ranges for the 
Current sensor. 

The values available are: 
0 mV to 100 mV 
0 V to 1.0 V 
0 V to 5.0 V 
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Scale 

• Press  to change between the two Scales available: 1 
mV/amp and 10 mV/amp. 

 

Displacement Sensor 

When using the Displacement sensor type you can select the type of 
Machine and the Mode to profile in. 

 

Note: Do not plug a Thermocouple into the PRTC Module while the 
profiling sensor is connected. 

• Press  to change between Commutator and Slip ring 
machine types. 

• Press  to change between Peak height and Shape 
profiling Modes. 

Type 
The Sensor and Machine type is saved with the Data Set. These will 
always be restored to the saved type in subsequent recordings. You 
cannot change the Machine and Sensor types (as described above) 
after recording one or more recordings without also changing the 
Data Set number. This is because the instrument expects the same 
Data Set type for each successive recording. The instrument 
automatically selects the next highest compatible Data Set number 
when the Machine or Sensor type is altered. 
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Mode 
The Peak height mode records one value per bar (or segment), this 
being the peak height of multiple samples taken across the entire bar 
or segment. Since the high points of the bar determine the deflection 
of the brushes, these values are of most relevance when comparing 
heights of adjacent bars. 

The Shape mode records a value in steps of approximately 0.5 mm 
as it travels around the commutator bars or slip ring segments. Using 
these values Shape mode will generate a shape of the commutator 
or slip ring. 

The Peak heights are measured using the maximum resolution and 
accuracy of the instrument. The Shape mode does not measure 
displacement with any greater accuracy. The Shape mode records a 
larger number of samples across each bar, thus enabling a profile of 
the bar to be recorded, which allows wear patterns and irregularities 
to be inspected. 

Since recording in Shape mode stores multiple samples for each bar, 
this Mode uses up the available memory much quicker than with 
Peak height recording. 

Printouts of Bar Shape take considerably longer than those of Peak 
height. A 300 bar commutator will take more than two hours to print 
out on the supplied thermal printer. It is strongly suggested that, 
should you require to see bar shape, you download the data to the 
MAS software for analysis. Bar Shape is not necessary for general 
maintenance procedures. 

Note: Recordings using Shape mode can be confusing as even very 
small variations will be shown. Typically these small variations have 
no relevance for general maintenance and are useful only in 
laboratory situations. 

 



 
 

 Section 2: Basic Operation 
 
26 

Measure Without Recording 

This menu allows you to complete the setup before performing an 
actual recording. 

 

Use this menu to set up the Displacement sensor for its zero 
position. Refer to Displacement Measurement Setup (page 33) for 
more information on how to set up the Displacement sensor. 

 

Modifying the Units 

• Press  Metric/Imperial to change between metric and 
imperial units. 

Note: You can only change units for Temperature and Displacement 
sensors. Current can only be measured in amperes. 

 

Changing Resolution 

• Press  to change the resolution of the displayed 
measurement. 

Note: To change the resolution for Displacement measurements you 
must set the sensor at fewer than 0.2 mm (8 mil). Refer to 
Positioning the Sensor Head (page 34) for details on sensor 
positioning. 
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The resolution options are: 

Sensor Metric / Imperial Resolution 

Metric 
0.01 mm or 

1 µm (micron) Displacement 

Imperial 1 Mil or 0.01 Mil 

Metric 1 °C or 0.1 °C 

Temperature 

Imperial 1 °F or 0.1 °F 

 
Note: You cannot change the resolution of Current measurements. 

 

Measurement Zero 

This option is only available for Current sensor measurements. 

• Press  Measurement Zero to set the zero point for a 
measurement. 

 

Display Options 
The Display Options Menu allows you to change the way the data is 
displayed on screen. 

• Press  Display Options to display this menu. 
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Display Type 

This option is used to change the appearance of the measured data. 

• Press  Display type to change between a Graphic or 
Digital display. 

• In Graphic display mode press  to change from Solid to 
Line mode. 

 

Update at 

For Temperature and Current type measurements you can change 
the update speed. 

• Press  Update at, to cycle through the update speeds 
(50, 100, 250, 500, 1000, 2000) ms. 

 

New Recording 

Enter the settings for a new recording in the New Recording screen. 

To display the New Recording Menu: 

• From the Measure Without Recording Menu press  
OR 

• From the Main Menu press  
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Type 

This option will take you back to the Measurement Setup Menu 
where you can change the type of sensor that is being used for the 
measurement.  

• Press  Type to display the Measurement Setup Menu. 

• Press  to display the Measure Without Recording Menu 
where you can complete the setup for the measurement. 

• To return to the New Recording Menu press  New 
Recording. 

 

Data Set 

This option allows you to select a Data Set to store the recordings. 
The number of the currently selected Data Set is displayed next to 
this option. 

• From the New Recording Menu press  Data Set. 

• Use  and to highlight a Data Set then press  to 
select it. 

Note: Each Data Set can only store the same types of recordings. If 
you change the setup of the sensor and/or the type of recording to 
be taken the instrument will move to the next highest available Data 
Set to store the recordings in. 

 

ID 

This option lets you rename any Data Set. The name can be up to 16 
characters in length. 

• From the New Recording Menu press  ID to display the 
Edit Name Menu. See Editing Data Set ID's (page 17) for 
details of how to edit a Data Set name. 
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Size 

This option lets you specify the number of samples/segment/bars for 
the measurement. 

• Press  Size to enter the number of 
samples/segments/bars. 

 

Recording 

This option lets you specify the recording number of the 
measurement that is to be taken. If the recording number is not 
changed it will progress through the Data Set from recording 1 to 
recording 50 automatically. 

• Press  Recording to change the recording number. 

Note: Only numbers that have no measurements associated with 
them are available for selection. 

 

Sample at 

This option sets the sampling interval for Current and Temperature 
recordings. 

• Press  Sample at. 

• Press  and  to select the range of the sampling 
interval. 

The available ranges are hours, minutes, seconds and milliseconds. 

• Enter the desired sampling interval using the numeric keys. 
The available sampling interval is from 100 milliseconds to 
60 hours. 

• Press  to save your settings and continue. 
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Recording Options 
The Recording Options Menu allows you to toggle the Autosize and 
Sample beep features ON and OFF. 

To display the Recording Options Menu: 

• From the Measure Without Recording Menu press  

OR 

• From the Main Menu press  

• Press  Recording Options. 

 

AutoSize 

Autosize sets the Size value to the total number of 

samples/segments/bars recorded when the  button is pressed to 
stop the recording. 

• Press  AutoSize to toggle this option ON and OFF. 

 

Sample Beep 

Sample beep will cause the instrument to beep when each sample is 
recorded. 

• Press  Sample beep to toggle this option ON and OFF. 
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Section 3: Taking 
Measurements 

This section describes the procedures for performing advanced 
operations on your instrument. 

You will learn to: 

• Take Displacement measurements 

• Take Current measurements 

• Take Temperature measurements 

• Review a recording in a Data Set 

• Print and download a Data Set to a PC 
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Measuring Displacement - Profiles 

Displacement Measurement Setup 

Before a profile recording can be made the machine type must be 
known. Machine type is defined as a slip ring (or any other smooth 
surface) or a commutator that is to be profiled.  

• From the Main Menu press  Measurement Setup. 

• Change the Sensor to Displacement and select the desired 
Type of machine that is to be profiled. 

• Select the Mode that you wish to record in - Peak height or 
Shape. 

• Press  to display the Measure Without Recording Menu. 

• Select the preferred display units (metric or imperial) and the 
display Resolution required. 

• Setup the Display Options by pressing  Display Options. 

Notes 

The units selected have no effect on the data recorded and the units 
can be changed at any time without any change to the data. 

The preferred units can be set as the default as the setting is saved 
permanently, provided the internal backup battery is not allowed to 
go flat. 

The selected resolution has no effect on the recorded data as the 
highest resolution is always used. 

When viewing the data in Graphic display type it is easier to read the 
data when the solid option is selected. 
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If you are recording using Peak height mode you will still see the 
actual shape of the bars displayed on the LCD if you have the 
Display Type set to Graphic. 

Tips 

After using Shape mode to record a machine you can print data (or 
send data to the software) using the standard resolution (only the 
Peak heights are printed). The reverse is not possible for Peak 
height recordings. 

Recordings can be converted from Shape to Peak height mode (or 
vice versa) before being printed or sent to the MAS software. See 
Printing Options (page 46) for more information. 

 

Positioning the Sensor Head 

For best accuracy and greatest measurement range the sensor head 
should be positioned in the brush holder mid-way of its displacement. 
The Measure Without Recording Menu assists with the positioning of 
the sensor head by displaying the actual displacement. The optimum 
displacement is ± 0.00 mm (± 0 mil) however anywhere between ± 
0.2 mm (± 8 mil) is acceptable. 

• Fully retract the clamp by rotating the clamp knob anti-
clockwise. 

• Fit the sensor head into a vacant brush box with the 
appropriate number of packing pieces to loosely retain the 
sensor head – do not tighten yet. The sensor should be 
positioned square in the brush box (like a brush) and on a 
bar (if a commutator is being measured), not in the gap 
between bars. 

• Mark the armature of the machine under test with the felt pen 
provided. 
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• Now rotate the machine to position the sensor adjacent to 
the reference mark. If you are measuring a commutator, 
position the sensor wheel approximately in the center of the 
marked bar - not in a gap between bars. This ensures that 
the bars are correctly detected when recording (the 
instrument expects abrupt steps as caused by the gaps 
between commutator bars). 

• When the sensor head is approximately in position, tighten 
the clamp sufficiently in order to hold the sensor head in 
position by turning the knob clockwise (do not use any tools 
or levers as overtightening may damage the sensor and 
clamp). 

The sensor must be located in the brush box so the display reads ± 
0.2 mm or ± 8 mil or less. 

Tips 

• Position the sensor at around -0.3 mm (-12 mil) then tighten 
the sensor while watching the display. The sensor will 
naturally pull itself in towards zero. 

• In situations that require external mounting of the sensor 
head, use the sensor sleeve and C clamp supplied. Under 
no circumstances should the sensor head be clamped 
directly with any form of clamp. 

• Finally, rock the armature back and forth slightly to stabilize 
the sensor mechanism. 

• After ensuring the sensor is still located approximately in the 
middle of the marked bar, check the display still reads ± 0.2 
mm (± 8 mil) or less. 

 



 
 

 Section 3: Taking Measurements 
 
36 

Measure without Recording 

• To count the bars or check the shape without recording 

press  

• When you have finished press  

 

Recording a Profile 

To start recording a new profile while in the Measure Without 
Recording Menu: 

• Press  New Recording. 

• Select the desired Data Set to store the recording(s) by 

pressing  Data Set. 

• Give the Data Set a meaningful name such as the type of 
data it will store. 

• Press  ID to access the Edit Name Menu and enter a 
new ID name for the Data Set. 

• Edit the Size of the recording to be taken by pressing  
Size. (The number of bars or segments set for the previous 
recording will be displayed.) 

• If the number of bars or segments is unknown press  
when setting the Size until ? appears. 

If the number of bars is preset by specifying the Size, the 
recording will automatically be terminated when that number 
of bars/segments is reached. If the Size is set to ? then 

recording must be terminated manually by pressing  

The present recording number is displayed and will be 
incremented on subsequent recordings. 
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• If another Recording number is required press  
Recording, and select the next Recording number from the 
list. 

• Press  Display Options if you wish to display the 
recording in a different view from the one selected in the 
Measure Without Recording Menu. 

• Ensure the sensor head is adjacent to the reference mark 

made earlier on the commutator then press  to begin the 
recording. 

When recording a profile the commutator/slip ring must be 
rotated from front (clamp side) to the rear of the sensor 
head, as shown in the following diagram. 

 

As the machine is rotated the screen will display the number 
of bars or segments detected. The number displayed 
indicates the previous bar or segment. The recording will 
automatically stop when the preset number of bars has been 
recorded. 

• If the number of bars was not entered you will need to 

manually stop the recording by pressing  when you 
reach the desired point. 
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Tips 
The Data Set number can be changed to any number from 1 to 50 
(exluding any numbers assigned to existing recordings with the same 
measurement type as the proposed new Data Set). The cursor will 
automatically skip incompatible Data Sets when selecting a new 
Data Set. 

When assigning names to individual Data Sets (Data Set ID) we 
recommend that you use descriptive titles (up to 16 characters) for 
future identification and review, as up to 50 Data Sets may be 
recorded and stored. 

You can change the Graph type by pressing  at any time during 
graphical display. The change only applies to bars or segments 
recorded from that point on. 

 

Measuring Temperature 

Temperature Measurement Setup 

Note: Do not plug the Displacement Sensor into the PRTC module 
while the thermocouple is connected. 

• Connect the K type thermocouple to the PRTC module 

• From the Main Menu press  Measurement Setup. 

• Change the Sensor to Temperature. 

• Press  to display the Measure Without Recording Menu. 

• Select the preferred display units as Metric (Celsius °C) or 
Imperial (Fahrenheit °F), and the display Resolution 
required. 

Notes 
The units selected have no effect on the data recorded and the units 
can be changed at any time without any change to the data. 
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The preferred units can be set as the default as the setting is saved 
permanently provided the internal backup battery is not allowed to go 
flat. 

The selected resolution also has no effect on the recorded data as 
the highest resolution is always used. 

 

Recording Temperature Data 

• Press  New Recording. 

• Press  Data Set to change the currently selected Data 
Set if required. 

• Press  ID to display the Edit Name Menu and change the 
ID name of the selected Data Set. 

• Set the number of samples by pressing  Size and enter 
the number of samples that are required. If the Size has not 
been entered, or there have been no previous recordings in 
the selected Data set then the Size will be ? 

If the Size is defined as a number of samples, the recording 
will automatically be terminated when that number of 
samples is detected. If the Size is not defined as a number of 
samples (? samples) then the recording must be terminated 

manually by pressing  

• To change the Recording number press  Recording. 

• Set the Sampling interval for the measurement by pressing 

 Sample. 

• The sampling interval can be set from 100 milliseconds to 60 

hours by selecting the range using  and , then 
entering the numerical value with the number keys. 



 
 

 Section 3: Taking Measurements 
 
40 

• Press  to return to the New Recording Menu. 

• Setup the Display Options by pressing  Display Options. 

• Change the Update at option by pressing  to cycle 
through the values of (50, 100, 250, 500, 1000, 2000) ms. 
This is the speed at which the display is updated. 

• Press  to return to the New Recording Menu. 

• Before starting your recording ensure you have plugged the 
K type thermocouple into its socket on the PRTC module 
and fastened the sensor end to the object under test. Do not 
connect the thermocouple to any live surface. 

• Press  to initiate the recording. When the number of 
preset samples has been reached the recording will be 
terminated automatically. 

• If at anytime you need to terminate the recording press  

Notes 
The Beeper will not work when the sampling interval is set for 
milliseconds. 

• If you require the instrument to Beep each time it takes a 
sample you can do this by turning on the Sample beep 
option in the Recording Options Menu. To display the 

Recording Options Menu press  Recording Options from 
the New Recording Menu. 

• Toggle the Beeper on or off during recording by pressing 
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Measuring Current 

Current Measurement Setup 

• From the Main Menu press  Measurement Setup. 

• Change the Sensor to Current. 

• Select the Input Range of the current sensor by pressing 

 Input Range to cycle through the options of, 0 mV to 
100 mV, (0 to 1.0) V and 0 V to 5.0 V. 

• Select the Scale of the input by pressing  Scale to 
change between 1 mV/amp or 10 mV/amp. 

• Press  to display the Measure Without Recording Menu. 

 

Sensor Setup 

The DC Current sensor must be plugged into the instrument and 
turned on in order to zero the instrument display. Ensure the sensor 
is not connected to the load at this point. 

• Plug the DC Current sensor into the PRTC module. 

• Press  Measurement Zero to zero the displayed current. 

 

Recording Current Data 

The procedure for recording Current data is identical to that for 
recording Temperature data. Please refer to Recording Temperature 
Data (page 39) for information on how to carry out this procedure. 

Ignore the reference to using the K type thermocouple as this does 
not apply to Current recordings. 
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Reviewing a Data Set 

• To review a recording on the instrument, from the Main 

Menu press  Review Data Set. 

• Use  and  to select the Data Set that you wish to 
review. 

• Press  to accept the selection of the Data Set and 
display the Review Data Set Menu. 

 

Dataset Number (No.) 

This option allows you to change the number of the Data Set that is 
being reviewed. 

• To change the current Data Set press  No. and use  

and  to select the Data Set that contains the recordings 
you wish to review. 

 

ID 

This option allows you to change the Data Set ID of the currently 
selected Data Set. 

• To change the ID of the Data Set press  ID to display the 
Edit Name Menu. 

 

Recording 

This option allows you to select the recording in the data set to be 
reviewed. 

• Press  Recording then use  and  to select the 
recording to be reviewed. 
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Display Options 

This option allows you to change some of the Display Options to 
different values than those used to take the recording that you are 
reviewing. 

You can change the Display type and Unit type (Metric/Imperial) but 
not the resolution. 

• Press  Display Options and change the options as 
required. 

 

Print or Download Data Set 

This option allows you to change from the Review Data Set Menu to 
the Print or Download Data Set Menu. 

• Press  Print or Download Data Set to open the Print or 
Download Data Set Menu. 

• To return to the Review Data Set Menu press  Review 
Data Set. 

Refer to Print or Download Data Sets (page 45) and the topics that 
follow it for more information on printing. 

 

Start at 

This option allows you to specify a starting point for reviewing the 
selected recording. This is useful for examining the measurements 
around a known position of a recording that contains a substantial 
number of samples/segments/bars. 

• Press  Start at, to display the Start at Menu. 

• Press the numerical keys to enter the number of the 
sample/segment/bar to start at. The total number of 
samples/segments/bars is also displayed on the screen. 
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Note: If you enter a number that is larger than the number of 
samples/segments/bars, a ? character is displayed as the Start at 
position. If you then return to the Review Data Set Menu the Start at 
position will be set to the first sample/segment/bar. 

 

Reviewing the Recording 

• Press  to start reviewing the selected recording. 

• Press   to clear the screen and return to the 
specified Start at point. 

• Press  to cycle through the recorded 
samples/segments/bars. You can scroll through the data 

progressively faster by holding down  

• Press   to zoom out the displayed recording. When 
you reach the maximum zoom out point the display will 
return to the closest possible view. 

• Press   to zoom in on the displayed recording. When 
you reach the maximum zoom in point the display will return 
to the furthest possible view. 

• Press  and  to move the y axis up and down on the 
screen. 

• Press  to stop reviewing the selected recording and 
return to the Review Data Set Menu. 
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Reviewing Short Cut Keys 

  
Clear the screen and return to the Start at 
sample/segment/bar 

  
Zoom out 

  
Zoom in 

 
 
Move up the y axis 

 
 
Move down the y axis 

 
 
Move through the recording one sample/segment/bar at 
a time. Holding down this key makes the data scroll 
progressively faster. 

 
 
Exit the Review Menu 
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Print or Download Data Sets 

This set of menus is almost identical to the Review Data Set menus. 
Please refer to Reviewing a Data Set (page 42) for definitions of the 
options displayed on screen. 

 

Printing Options 

This is the only option that is different to the Review Data Set Menu. 
It allows for various printer and printing setups to be selected. 

• Press  Print or Download Data Set from the Main Menu. 

• Press  Printing Options. 

• Press  Printer to cycle through the supported printer 
types. 

• Commutator and slip ring recordings can be converted from 
Shape to Peak height mode (or vice versa) before being 

printed or sent to the MAS software. Press  Mode to 
toggle the mode before sending recordings to the printer or a 
PC. 

• Press  Metric/Imperial to change between metric or 
imperial units before printing. 

Notes 
The Seiko DPU type printers are not designed for fast operation e.g. 
a Shape printout of 300 bars will take over 2 hours to complete. We 
suggest that you download any Shape recordings to the software.  

A Shape printout is not possible if the Data Set has been recorded 
using Peak Height. 
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Printing from the Instrument 

Warning: When using the DPU-414-30B printer, use only the Seiko 
power adapter provided (6.5 V output). Printer damage will occur if 
any other power adapter is used. 

Note: When using the DPU-414 printer, ensure that the internal 
battery is charged prior to operation. If the battery is flat the printer 
will switch itself 'Off Line' and printing will cease. 

The profiler instrument supports three different printer types: 

The Seiko DPU-411-00SU dot matrix thermal printer  

The Seiko DPU-411-043 

The Seiko DPU-414-30B (serial interface) 

The printer type must be 'known' by the instrument as the three 
different types respond differently to character and control codes 
sent by the instrument. The instrument stores the selected printer 
type as the default eliminating the need for routine printer type 
selection if the same printer type is always used. 

The profiler instrument comes standard with the DPU-414-30B serial 
interface printer. 

Regardless of which printer you use, the instrument transmits data in 
serial form. To use any of listed the printer types, you will require the 
supplied male 9-pin D-type downloading cable. 

• Plug the printer cable 'D' connector into the printer serial 
input and the 5 pin connector plug into the instrument's 
RS232 port. 

• Switch the printer on and ensure the ON LINE indicator 
(green) is on (press the ON LINE button if necessary). 

• From the Main Menu press  Print or Download Data Set. 
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• Select the Data Set that contains the recordings that you 

wish to print by using  and  then press  to select 
the Data Set. 

• Select the recording(s) to be printed by pressing  
Recording. 

• Use  and  to select an individual recording or to 

select the All option. Press  to accept the selection. 

• Press  Printing Options. 

• Press  Printer to select the Printer type connected to the 
instrument. 

• Press  Metric/Imperial to toggle the printed units from 
metric to imperial. 

• Press  to return to the Print or Download Data Set Menu. 

• Press  to begin printing. During printing, the current Data 
Set and recording number is displayed on  screen. 

• To stop printing press  

Note: The instrument will display a 'No Printer' message on the 
screen if the printer runs out of paper, the cable is not connected, the 
printer has flat batteries or the printer has a fault. 
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Printer Setup and Information 

Note: The DPU-411-00SU and DPU-414-30B printers do not feature 
a quick charge facility. We recommend you discharge the printer 
battery prior to charging, by leaving the instrument switched on until 
the battery is completely drained. The printer can then be charged 
using the correct power transformer provided. The printer battery 
should be charged for 10 to 16 hours. 

 

Printer DIP Switch settings 

Model DPU-411-00SU (serial only) 

Switch Function Switch Setting Status 

1 Input Selection ON - 8 bits Essential 

2 Parity Permission ON - Without Essential 

3 Parity Setting ON - odd Essential 

4 Baud Rate OFF - 9600 Essential 

5 Baud Rate OFF - 9600 Essential 

6 Baud Rate OFF - 9600 Essential 

7 Auto line feed OFF -  Essential 

8 Zero Form OFF -  Optional 
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Model DPU-411-043 (serial/parallel) 

8 way DIP switch 

Switch Function Switch Setting Status 

1 Input Format OFF- Serial Essential 

2 Auto Line Feed OFF Essential 

3 # of Columns ON - 80 Essential 

4 Characters OFF (Std) ON ('Type II') 

5 Zero Form ON Optional 

6 International Chr's OFF  Optional 

7 International Chr's ON Optional 

8 International Chr's ON  Optional 

 

6 way DIP switch 

Switch Function Switch Setting Status 

1 Data Bit ON - 8 Essential 

2 Parity Permission ON - Without Essential 

3 Parity Setting ON - odd Essential 

4 Baud Rate OFF - 9600 Essential 

5 Baud Rate OFF - 9600 Essential 

6 Baud Rate OFF - 9600 Essential 
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DPU-414-30B Printer Setup 

The DPU-414-30B has a virtual DIP SW which should be set up the 
first time the printer is used. You may need to reset operational 
settings if the supply voltage is interrupted. 

Caution: Never turn the printer off while it is writing the new setting 
to memory. Always wait until DIP SW setting complete !! is printed 
before turning the power off. 

To set the virtual DIP SW, begin with the DPU-414-30B switched off 
and complete the following procedures: 

• Slide the power switch to ON while pressing the ON LINE 
button. 

• Release the ON LINE button after a list of the current 
settings starts printing out. 

The printout of the current settings is followed by the prompt: 

Continue ? :Press On-line SW 
Write ? :Press Paper feed SW 

• To change the DIP SW settings press the ON LINE button. 

• To leave the DIP SW settings unchanged press the FEED 
button. 

After pressing the ON LINE button, DIP SW1 is printed, prompting 
the input of new settings for switch numbers 1 through 8 of DIP SW1. 
Refer to the following table for the required settings to print from the 
instrument. Always input either ON or OFF for every setting for 
switch numbers 1 through 8 because DIP SW Set mode cannot be 
cancelled once it is initiated. 

• ON can be set by pressing the ON LINE button once and 
OFF by pressing the FEED button once  

The setting is printed out after the ON LINE or FEED button is 
pressed to confirm the new setting. 
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As soon as switch number 8 is set the printer once again prompts 
Continue ? or Write ?. Continue ? (ON LINE) allows DIP SW2 and 
DIP SW3 to be set in turn, and Write ? (FEED) exits DIP SW setting 
mode. 

After the FEED button is pressed, the ON LINE and OFF LINE lamps 
alternately blink and the new settings are written to memory. When 
the printer finishes writing everything to memory, 'DIP SW setting 
complete !!' is printed out and the printer returns to the ON LINE 
mode. 

As soon as switch number 8 of DIP SW3 is set, the printer writes the 
settings to memory regardless of which button is pressed. 
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DPU-414-30B 'Virtual' DIP Switch Settings 

DIP SW Switch 
No. 

Function Switch 
Settings 

Status 

DIP SW1 1 

2 

3 

4 

5 

6 

7 

8 

Input = Serial 

Printing Speed = High 

Auto Loading = ON 

Auto Line Feed = OFF 

Setting Command = Enable 

Printing  

 Density 

 = 93% 

OFF 

ON 

ON 

OFF 

ON 

ON 

OFF 

OFF 

Essential 

Optional 

Essential 

Essential 

Essential 

Optional 

Optional 

Optional 

DIP SW2 1 

2 

3 

4 

5 

6 

7 

8 

Print Columns = 40 

User Font Backup = ON 

Character Select = Ordinary 

Zero = Normal 

International 

 Character 

 Set 

 = England 

ON 

ON 

ON 

ON 

ON 

ON 

OFF 

OFF 

Essential 

Optional 

Essential 

Optional 

Essential 

Essential 

Optional 

Essential 

DIP SW3 1 

2 

3 

4 

5 

6 

7 

8 

Data Length = 8 bits 

Parity Setting = No 

Parity Condition = Odd 

Busy Control = H/W Busy 

Baud 

 Rate 

 Select 

 9600 bps 

ON 

ON 

ON 

ON 

OFF 

ON 

ON 

ON 

Essential 

Essential 

Essential 

Essential 

Essential 

Essential 

Essential 

Essential 
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Section 4: Utilities 

This section describes how to use the utility functions of your 
instrument. 

You will learn to: 

• Adjust the LCD 

• Set the clock 

• Manage the battery pack 

• Manage memory usage 
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Adjusting the LCD Screen 

Adjusting the Contrast 

• From the Main Menu press  to darken the LCD. To 

lighten the LCD press  

If the screen flickers when cursors are moved make the LCD darker. 

 

Restoring the Default Contrast 

• From the Main Menu press   to restore the default 
contrast. 

 

Turning the Backlight On 

• To toggle the backlight ON and OFF press   

 

Setting the Date and Time 

• From the Main Menu press  Date & Time. 

• To cycle to a particular item press . The item will flash to 
show that it is selected. 

• Use  and  to change the value of the currently 
selected item. 

• Press  to save changes and exit. 

All recordings are date and time stamped according to the clock 
shown in the Date & Time Menu. 
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Battery Management 

The instrument is powered by a rechargeable Nickel-Cadmium (Ni-
Cad) battery pack. The normal operating range is 6.0 V to 8.5 V. The 
Battery Management Menu displays the current percentage of full 
battery charge available. 

Some automatic features have been built into the instrument to help 
ensure that the battery pack is always sufficiently charged.  

Below 6.6 Volts, the instrument displays a flashing  icon at the 
top left corner of the screen and beeps once every minute as a 
reminder that the battery pack needs to be charged. In the Battery 
Management Menu a flashing 'Low Battery' message is also 
displayed. 

Below 6.1 Volts, the instrument automatically turns off the backlight 
to prevent further power draining.  

Below 80% battery capacity, the instrument automatically begins to 
charge the battery pack if external power is supplied. 

At 5.5 Volts, the instrument automatically powers down. The power 
saver is another feature that helps conserve power. 

The instrument is equipped with an internal backup component that 
protects data and settings in case the battery pack is momentarily 
removed from the instrument. The backup component is kept 
charged by the battery pack if the battery pack is functioning 
normally. 

Warning: Do not detach the battery pack from the instrument for 
more than 2 hours as this will drain the backup component, thereby 
causing data and setting to be lost. 

Warning: Before charging the battery pack, ensure that the power 
transformer used is an approved instrument power transformer 13.5 
V ± 1.5 V DC, 1 A output, center positive, and that the voltage and 
frequency of your mains AC power matches that of the power 
transformer. 
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The battery pack can be charged by supplying 13.5 V ± 1.5 V DC, 1 
A power to the instrument charger socket. The power transformer 
supplied in the kit provides this DC voltage. The optional car adapter 
charging lead may also be used to charge the battery pack in a 
vehicle with a 12 V negative-chassis power system. 

 

Checking the Battery Charge and Voltage 

• From the Main Menu press  Battery Management. The 
remaining battery charge and voltage are displayed. 

 

Charger Control 

This menu allows manual control of the battery charge function. The 
current battery voltage and charging state are displayed. 

 

 
Charge Battery 
Manually begins battery charging cycle. 

 
Recondition Battery 
Fully discharges, and then automatically recharges the battery. 

 
Fresh Battery Inserted 
Resets the battery capacity scale percentage to 100% at the 
current battery voltage.  

These options are explained in detail in the following pages. 
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Recharging the Instrument 

Warning: Read the warnings in the Battery Management section 
before charging the battery. 

• Plug the power transformer into a standard power outlet and 
the connector to the instrument’s charger socket. 

If the battery charge level is less than 80% the battery will begin 
charging automatically. You can continue to use the instrument while 
the battery pack is being charged. 

If the battery does not begin charging automatically follow the 
instructions below to begin charging. 

• From the Main Menu press  Battery Management. 

• Press  Charger Control.  

• Press  to begin charging. A flashing 'CHARGING' 
message will be displayed. 

If there is no power coming from the power transformer, a flashing 
'NO CHARGER' message will be displayed. If this happens check 
that the mains power is turned on.  

Charging stops automatically when complete or you can press  
when in the Charger Control Menu to stop it. A full charging cycle 
takes approximately 2 1/2 hours. All other functions are usable while 
the battery pack is being charged. 
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Reconditioning the Battery Pack 

Warning: Read the warnings in Battery Management (page 56), 
before performing this operation. 

Battery reconditioning is the process of first discharging and then 
recharging batteries. It reduces the undesirable memory effect in the 
Ni-Cad battery. The battery pack should be reconditioned the first 
time it is used and at least once a month thereafter to prevent battery 
degradation. The recondition process will take up to two hours, 
depending on initial battery charge. 

Caution: If the battery pack is not reconditioned the first time it is 
used, the battery charge displayed may be incorrect. 

• Plug the instrument power transformer to a standard power 
outlet and its connector to the instrument charger socket. 

• From the Main Menu press  Battery Management. 

• Press  Charger Control. 

• Press  to recondition the battery. Discharging is 
indicated by the flashing 'DISCHARGING' message on the 
screen. 

The instrument automatically proceeds to charge the battery once 
the battery pack is fully discharged. 

 

Fresh Battery Inserted 

This resets the battery capacity scale percentage to 100% at the 
current battery voltage. This option should be used when a new, fully 
recharged battery is exchanged for a discharged battery. 

Caution: If this selection is made when the attached battery is not 
fully charged the battery capacity scale will no longer be set 
accurately. Performing a Recondition Battery will recharge the 
battery and reset the scale. 
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Power Saver 

Power saver is a feature that helps conserve power in the 
instrument. Power saver will turn the LCD display off after 8 minutes 
of inactivity (no key presses). The instrument will continue to function 
and any key press will turn the LCD on to the previously displayed 
screen. After 15 minutes of inactivity Power saver will power down 
the instrument. If the battery is being recharged, only the LCD screen 
will be turned off and the instrument will remain on until charging is 
complete. 

The Power saver is automatically turned on every time the 
instrument is powered up. You may turn it off temporarily by toggling 
Power saver OFF from the Battery Management Menu. 

• To turn off Power saver, from the Main Menu press  
Battery Management.  

• Press  to toggle Power saver ON and OFF. 

 

Replacing the Battery Pack 

• Lift the boot stand. 

• Unscrew the battery pack using a suitable screwdriver and 
screw in the new one. 

Warning: Ensure that the battery pack is securely fastened but not 
over-tightened. 
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Memory Management 

The Memory Management Menu allows for checking the amount of 
memory used by recordings and the deletion of recordings, Data 
Sets and even the entire memory contents. 

• From the Main Menu press  Memory Management. 

 

The amount of memory currently used is displayed on screen in a 
percentage format, along with the total memory size and the number 
of Data Sets that are being or have been used. 

 

Erasing a Data Set 

To erase a complete Data Set and leave all other Data Sets and 
Settings intact: 

• From the Main Menu press  Memory Management. 

• Press  Erase Data. 

• Press  Select Data Set and use  and  to select 
the Data Set to be erased. 

• Press   to delete the selected Data Set. 

Warning: The instrument will not ask for confirmation when deleting 
a single Data Set. 
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Erasing a Recording 

To erase a single recording from a Data Set and leave all other 
recordings intact: 

• From the Main Menu press  Memory Management. 

• Press  Erase Data. 

• Press  Select recording and use  and  to select 
the recording to be erased. 

• Press   to delete the selected recording. 

Warning: The instrument does not ask for confirmation when 
deleting a single recording. 

 

Erase All Memory 

Warning: Following the procedure below erases ALL folders and 
ALL recordings in the instrument. 

Before erasing data you may wish to archive it on your PC. See 
Transferring Data to a PC (page 70), for more information. 

• To erase all data sets and recordings, from the Main Menu 

press  Memory Management. 

• Press  Erase Data. 

• Press   twice to erase the memory of the instrument. 

Warning: Erase All Memory will reset the instrument to factory 
default settings. 
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Section 5: Troubleshooting 

Resetting the Instrument 

If the electrostatic discharge exceeds 8 kV the instrument may not 

respond to any key presses (including  presses). In such cases 
you must reset the instrument as soon as possible as it will continue 
to draw power until it is reset and turned off. 

• In any screen hold down  and press  then release to 
reset the instrument. 

Resetting the instrument does not erase data or settings stored in 
the instrument. 

 

Data Problems 

Symptom Cause Remedy 

Data lost when battery 
pack detached for more 
than 2 hours 

Flat backup battery Charge battery pack 

Send instrument to 
authorized dealer for 
servicing 

Data lost when battery 
pack replaced 

Flat backup battery Send in for servicing 

'Insufficient memory' 
displayed 

No memory space left for 
recordings 

Erase obsolete recordings 
(transfer to computer first 
if necessary) 

Measured data seems 
incorrect 

Sensor wired wrongly 

Faulty sensor 

Wire as recommended 

Replace sensor 

Beeps when recording, 
'Memory nearly full' 
displayed 

Only 200 samples 
approximately left free in 
memory 

Delete obsolete records 

'Memory full' displayed No memory left for 
recording 

Delete obsolete records 
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Data-Transfer Problems 

Symptom Cause Remedy 

'No PC?' displayed, and 
data cannot be transferred 
to the PC 

Data-transfer cable not 
properly connected 

Data-transfer cable 
connected to the wrong 
PC COM port 

Baud rate setting in MAS 
software too high 

Re-secure cable 
connections 

Test COM port availability 
and use available port 

 
Select a lower baud rate 
in MAS software 

MAS software unable to 
transfer data and 
'Transfer failed' or 'MAS 
Error Dialog' displayed on 
PC 

Baud rate setting in MAS 
sofware too high 

Select a lower baud rate 
in MAS software 

 

 

Power Problems 

Symptom Cause Remedy 

Instrument cannot power 
up 

Low battery level 

Electrostatic discharge 
(ESD exceeding 8 kV) 

Charge battery pack 

Reset instrument 

Instrument powers down 
when backlight is turned 
on 

Low battery level Charge battery pack 

Instrument powers down 
shortly after powering up 

Low battery level Charge battery pack 

 

 

Printing Problems 

Symptom Cause Remedy 

Stops or will not start 
Printing 

Flat Printer battery Charge printer battery 

Wrong characters in 
printout 

Wrong printer selected or 
incompatible type 

Select alternative type 

Will not print, 'No Printer 
?' displayed 

Printer not on-line, off, or 
not connected 

Turn on, select 'on-line' 
connect printer  

Check connection 
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Other Problems 

Symptom Cause Remedy 

instrument does not 
respond to any key press 

Electrostatic discharge 
exceeds 8 kV 

Reset the instrument 

 'Module Fault' displayed Module loose  

Module damaged 

Tighten  

Send in for servicing 

'Switch off then connect 
module' is displayed 

Module has worked itself 
loose (n.b. the module is 
where sensors are 
plugged in). 

 

Module is damaged 

Switch off the instrument 
and press firmly on the 
module or use an allen 
key to tighten it 

Reset instrument 

Test for module damage - 
switch off the instrument 
and plug in the battery 
charger. From the battery 
management menu press 
the ‘menu’ key. The main 
menu should appear 
without the model number 
(instrument3000/2000/100
0). This will confirm that 
the main instrument is OK 
and that the module is 
faulty. Send instrument to 
an authorized dealer for 
servicing. 

Data corrupted, 
'MEMORY ERROR' 
displayed 

Electrostatic discharge 
exceeds 8 kV 

Reset instrument 

Locks up when touched Electrostatic discharge 
exceeds 8 kV 

Reset instrument 

Continuously beeps when 
recording, 'High mica' 
displayed 

Wrong machine type, or 
very narrow bar gaps 

Select slip ring type 

Beeps when recording, 
'Speed' displayed 

Commutator turned too 
fast 

Reduce rotational speed 

Spurious steps in profile 
recording 

Sensor head moved Re-secure sensor 
clamping 

Regular oscillation in 
instrument recording 
(every 3 or more bars) 

Sensor wheel damaged Send in for servicing 
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Symptom Cause Remedy 

Erratic readings Dust on commutator Clean commutator or slip 
ring 

'Memory partition full' 
displayed 

No memory left for 
recording 

Delete obsolete records 
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Section 6: Analysis Software 

Recordings made on your instrument can be transferred to the 
profiler MAS software running on a Windows-based PC. MAS stands 
for Measurement Analysis Software. The MAS software can be used 
to store, graph, analyze, print and export your recordings. 

It is assumed that the user of MAS is already familiar with basic 
Windows commands. Please refer to the appropriate literature on 
Windows if clarification is needed on mouse and keyboard 
commands. 

Tips 

• When running the software press F1 on your keyboard to 
open a comprehensive, topic-specific Help screen. 

• Click the right mouse button anywhere in the MAS software 
to open a shortcut menu of the applicable commands. 
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Installing Profiler MAS 

System Requirements 

The following are the minimum PC system requirements for installing 
the software: 

• Pentium processor or better 

• 32 MB RAM (64 MB recommended) 

• 10 MB hard disk space 

• CD-ROM drive 

• Windows 95, 98, Me, NT 4.0 (SP6) or 2000 operating system 

• Windows compatible display and printer 

• Windows compatible mouse or other pointing device 

• An unused COM port for communicating with the instrument 

 

Installing MAS 

• Close all programs on your PC. 

• Insert the MAS CD-ROM into the CD-ROM drive. 

� Wait for the MAS installation program to automatically 
start. 

OR 
� Run the MAS Install.exe program located on the CD-

ROM. 

• Follow the on-screen instructions to complete the installation. 

 

Starting the Software 
When you install the software, program shortcuts will be created on 
the Desktop and in the Windows Start menu. 

• Double-click the MAS desktop icon. 
OR 

• Click the Windows Start Menu then choose 
Programs>Profiler MAS>Profiler MAS 5.00. 
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Configuring a PC COM Port 
To allow data transfer between the instrument and the PC, you must 
first configure your PC COM port as follows: 

• Connect the instrument to a COM port using the data-
transfer cable then power up the instrument. 

• From the MAS main menu click Tools>Configure COM 
port. 

• Select the COM port that the instrument is connected to. 

• Select a baud rate. The baud rate is the speed (in 
bits/second) at which data is transferred. The lower the baud 
rate the less likely that data-transfer errors will occur. 
'Automatic' is the default choice and is sufficient for normal 
transfers. 

• Click Test port. 

• Click Yes in the Confirm window to test the connection. If the 
connection fails see sub-heading 'Causes of connection 
failure' at the end of this topic. If the connection is good 
continue as follows: 

• Click OK in the second Confirm window to acknowledge that 
the instrument is attached to the COM port. 

• Click OK to exit the MAS Configuration window. 

Causes of connection failure 
If your PC fails to detect your instrument check the following: 

• The instrument is powered on 

• You have the selected the correct COM port that the data-
transfer cable is connected to 

• The data-transfer cable is plugged in firmly 

• The PC COM port is correctly configured (ask your IT help 
person for assistance with this) 
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Transferring Data to the PC 
Data transferred to the PC is stored in MAS files. These are text files 
and have a .mas extension. 

• To transfer data from the instrument to the PC power up the 
instrument. 

• Check the battery charge and if it is less than 30% charge 
the battery pack (see Recharging the Instrument on page 
58). 

• Connect the RS232 port of the instrument to the configured 
PC COM port using the data-transfer cable. 

• Start the software and click the Receive button. 

• On the instrument's Main Menu press  Print or Download 
Data Set. 

• Select the data set and recording(s) to transfer. 

• Press  to begin the transfer. Once the data-transfer is 
complete the data will appear in the current file in the 
software or, if no files were open, the data will appear in a 
new file. 

• To append more data from the instrument to the current file 
click Receive. 

• Alternatively, to receive more data but in its own new file 
click File>Receive from Profiler>Transfer to a New File. 

• To save the data in the current file (i.e. with the same name 
and in the same location) click Save twice.  To save the file 
with a new name or location click Save once then change 
the name/location as required and click Save again. 
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Using Help 

An extensive Help file is included with the MAS software. The Help 
system contains a wealth of detailed information not included in this 
reference guide and incorporates many screen shots to help 
illustrate procedures and concepts. If you have any difficulty 
understanding the procedures described in this reference guide or 
are unclear on some of the features of the software, please consult 
the Help file. 

• To access the Help file, from the Main Menu click 
Help>Contents. 

 

Managing Data 

The remainder of this reference guide will teach you how to view and 
manipulate your collected data. A sample data file has been included 
with the MAS software for you to experiment with. This file is called: 

Demo data.mas 

To work with this file use the instructions in the following topics to 
open, view and manipulate its contents. 

 

Opening a File 

• On the toolbar click Open. 

• Select your file and click Open. 

 

Merging Two Files 

• Open one of the files by clicking the toolbar Open button. 

• Select your file and click Open. 

• Click File>Import & Merge a file and select the other file to 
be merged into the open file. The merged data can be 
viewed but is not automatically saved on the PC. 
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• To save the file using the current name click File>Save or 
choose Save As to rename the file before saving. 

 

Using the Navigator 

When a file is open the navigator is displayed. The navigator 
consists of two panes on the left of the screen. The top pane shows 
all the folders in the file. The bottom pane shows all the recordings in 
the selected (highlighted) folder. 

 

Deleting Data from a Folder 

• Select the folder in the top (Datasets) section of the 
navigator. 

• In the bottom navigator (Recordings) select the individual 
recordings and/or channels to be deleted. 

• Click File>Delete Records or press the Delete key. 

• You will be prompted to confirm the deletion. Click Yes to 
confirm. 

 

Editing Recording Details 

• Select a folder to display the recordings contained within it 
then select the recordings and/or channels to be edited. 

• In the main window click the 'Info' tab to access the Info 
page. Here you can edit the User Details (e.g. Company 
Name, MMS serial number) Folder Name, and the Recording 
Details (e.g. recording name, remarks, channel labels and 
units). 

• In the 'User Details' section you can edit the Default User 
Details. These values are written to all future recordings 
while they are being transferred from the instrument. 
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Viewing and Printing Data 

• Open the file and use the navigator to select the recordings 
and/or channels to be viewed and/or printed. 

• Click the 'Values' tab. The data in the selected recordings 
and/or channels can now be viewed. 

• To change the value in a cell click the cell twice slowly and 
type in the new value. 

Note: For high-resolution (shape) profile recordings, each recording 
contains several sub-samples. These are all displayed but may not 
be edited. 

• To reduce the amount of data by averaging click Average 
(only available for data logger recordings). 

• To print the data click Print. 

• To copy the values to a spreadsheet program such as Excel 
click Copy (to clipboard), open your spreadsheet program 
and use its Paste command (this will normally be available 
from an Edit menu). 

• To print a report on the data click File>Summary Report or 
Generate Full Report and select the print option in the Data 
Summary or Report Generator window that appears. 

The Summary report produces a data summary of the selected 
recordings/channels. For more information consult the MAS Help file, 
which is available under Help>Contents. 
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Exporting data 

• In the navigator select the folders or recordings to be 
exported as a .mas file. 

• Click File>Export and select the option required. 

• Enter a name and choose a location for the export file then 
click Save. 

 

Calculating Data 
You can perform calculations on your data logger recordings by 
creating new 'calculated' channels. 

Note: You cannot perform calculations on profile recordings. 

• Open the file and use the navigator to select the recordings 
and/or channels to be used in calculations. 

• Click the 'Values' tab to display the data then click the 
toolbar Calculate button to open the Calculate window. 

Each channel is automatically given a 'tag' character that is used to 
identify the channel. It is a letter of the alphabet that can be used to 
reference the values of a recording for use in calculations. 

Expressions can then be derived using the provided functions and 
the channel tags, for example: 

TempChange = ChangePerHr(B) with units degC/hr 

This example will create a channel called 'TempChange' 
which is calculated as the rate of change per hour of the 
Channel which has tag 'B'. 

Constants can also be used in calculations. You may need to use 
constants in your expressions. 
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Example: 
To find the 'difference from the mean value' for a particular channel 
represented by 'tag' 'D'. 

• Define a constant to provide the mean value of channel 'D'. 

'K0 = Mean(D)' 

This constant is then used in the expression: 

'DiffFromMean = D – K0' 

See Appendix B: Profiler MAS Math (page 89) for a complete list of 
the functions available. 

 

Plotting Data 

Plotting Single and Individual Charts 

• Open the file and use the navigator to select the recordings 
and/or channels to be plotted. 

• Select the 'Chart' tab and click Plot. You can also plot a 
recording or channel by double-clicking it in the navigator. 

• To display the selected recordings and/or channels on 
individual charts, on the toolbar click Individual (available for 
data logger recordings only, not profiles). 

• To change the format of charts click Adjust to open the 
Adjust Axes & Colors window. This window allows you to 
change the axes and colors of the plotted recordings 
displayed on the chart. 

• To clear all plotted recordings, from the main menu select 
Chart>Clear Chart. 

• To retain existing plots when adding to the chart click Hold 
then double-click additional recordings to add them to the 
chart. A maximum of 16 plots can be displayed at a time 
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• To align Profile recordings click Rotate. Refer to Analyzing 
Profiles (page 80) for more details. 

• To enlarge a chart you can hide the legend by going to the 
main menu and de-selecting Chart>Show Legend. You can 
also Hide the navigator by selecting Window>Show 
Navigator. 

Note: If any recording(s) are plotted on either the 'Chart', 'Histogram', 
or 'Radial' tabs, the recording(s) will also be on the other tab views. 

 

Zooming and Panning 

Zooming and panning is available in the 'Chart', 'Histogram', and in 
restricted form 'Radial' tabs. 

To zoom in on any part of a chart 

• Left-click a place on the left side of the chart section you 
wish to zoom. 

• Hold down the mouse button while you drag a rectangle 
across and down to the right. 

• Release the mouse button to perform the zoom. 

To zoom in horizontally 

• Proceed as above, but only move the mouse directly left or 
right to select the area to be enlarged. Two vertical lines will 
be displayed across the chart to indicate the selection. 

To zoom in vertically 

• Proceed as above, but only move the mouse directly up or 
down to select the area to be enlarged. Two horizontal lines 
will be displayed across the chart to indicate the selection. 

To unzoom from any view 

• Left-click any place in the chart and drag a rectangle across 
and up to the left to display a rectangle with a cross in it. 
When you release the mouse button the chart will return to 
its original size and location. 
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Panning 
The chart can be dragged in any direction to display sections that are 
hidden from view. 

• To pan around the chart click anywhereand hold down the 
right mouse button in the chart display. The cursor will turn 
into a pointing hand icon. Drag the mouse pointer in the 
direction that you wish to move the chart. 

If you move the cursor off the chart you will have to release 
the right mouse button and return it to within the chart 
boundaries to continue panning. 

 

Printing Charts 

• On the toolbar click Print while the chart is displayed and 
click the Print button in this window to print the chart. 

Changing the color scheme 

• Choose the color scheme for printing by selecting a different 
scheme from the drop-down box (e.g. Black & White, Full 
Color or Color on White background). 

Creating report titles and headers 

• To add your own title and header click the Headers button. 

• Tick the boxes as required to allow text entry into the 'Report 
title' and 'Subheading' fields. 

• Type your headings then click OK. 

Previewing the report without printing 

• To see how your report will look when printed out click 
Preview. 

• When you have finished previewing the report click Close. 
Make further adjustments to the setup if required (changing 
the orientation etc) then preview again or click Print when 
you are satisfied. 
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Reading and Comparing Values 

To place cursors on charts to read the data values on curves: 

• Plot the recordings and/or channels on a single chart. 

• To place a cursor at a particular point on a curve, place the 
mouse cursor at that point, follow the curve until a crosshair 
appears then click the left mouse button. If the default cursor 
options are used, the cursor comprises a horizontal and a 
vertical dashed line, and the values indicated by the cursor 
are displayed at the edge of the chart next to the dashed 
lines. 

• To move the cursor to a different point on the same curve 
press the horizontal arrow keys. To move in small steps hold 
down the CTRL key when pressing the horizontal arrow 
keys. You can also move the cursor by clicking the left 
mouse button on the new point (first allowing a crosshair to 
appear). 

• To move the cursor to a different curve press the vertical 
arrow keys. Alternatively, click the left mouse button on the 
new curve or on the appropriate symbol on the legend. 

Placing a second cursor on the chart 

• Place the mouse cursor at the point of interest, follow the 
curve until a crosshair appears, and then click the right 
mouse button. If the default cursor options are used, the 
difference between the values indicated by the cursors is 
shown at the top right corner of the chart. Cursor A 
corresponds to left mouse button and cursor B to the right. 

Toggling between cursors 

• To toggle the focus between the cursors press the space bar 
- a cursor must be focused before it can be moved using the 
arrow keys. A cursor is focused if it has a rectangular target. 
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Removing the Cursors 

• To clear the cursors press the Esc key. 

Changing cursor options 

• To change cursor options click Chart>Cursor Options. 

Example 
 The pictured two-channel temperature recording has both cursors 
displayed (using the default cursor options). 

 

Each cursor displays the x and y axis values and the difference in 
both the x and y axis values of the two cursors in the top right hand 
side of the chart. 

Note: This feature is available on the Chart page only. 
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Plotting Waterfall Charts 

• Plot the recordings and/or channels on a single chart. 

• Click Chart>Waterfall Chart and select the depth required. 

Waterfall charts are useful for trending data behaviour. Cursor and 
zooming functions can be used on waterfall charts. 

Example 
The four curves on the waterfall chart below correspond to three sets 
of data pertaining to the same measurement point. This shows that 
the peak value has a rising trend. 

 

Note: This feature is available on the Chart page only. 
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Analyzing Profiles 

Histogram Chart 

The 'Histogram' tab lets you display profile recordings as bar-to-bar 
height (for commutator recordings) and segment-to-segment height 
(for slip ring recordings). 

• To plot the data for a commutator or slip ring on the 
Histogram select the recording(s) to be plotted. 

• Select the 'Histogram' tab and click Plot. You can also plot a 
recording or channel by double-clicking it in the navigator 
while having the 'Histogram' tab selected. 

Note: If any recording(s) are plotted on either the 'Chart', 'Histogram', 
or 'Radial' tabs, the recording(s) will also be on the other tab views. 

 

Radial Chart 

The 'Radial' tab lets you display profile recordings in a radial form. 
This view of recordings displays the data in a more natural way 
displaying the true shape of the commutator or slip ring (with a highly 
amplified radial scale). 

• To plot the data for a commutator or slip ring on the Radial 
Chart select the recording(s) to be plotted. 

• Select the 'Radial' tab and click Plot. You can also plot a 
recording or channel by double-clicking it in the navigator 
while having the 'Radial' tab selected. 

To adjust the Radial scale 

• Click Adjust, select the Radial axis options and enter the 
required value into the Radial scale box. 

Notes 
The scale of the Radial chart does not automatically change its 
range like the Chart or Histogram charts. This allows for easy 
comparison between recordings. 
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If any recording(s) are plotted on either the 'Chart', 'Histogram', or 
'Radial' tabs, the recording(s) will also be on the other tab views. 

The Radial Chart has restricted zooming options. All zooming to be 
performed is done in a square and not a rectangle. There are also no 
horizontal or vertical zoom options available on a Radial Chart. 

If more than one revolution was recorded on a commutator this can 
be corrected by setting the 'Actual Num Bars'. You can set the 
'Actual Num Bars' on the 'Info' page and this will cause the tail end of 
the recording to wrap around on the Radial chart. 

 

Rotating Profiles 

The Rotate button is available for the Chart and Radial pages This 
option allows you to align profiles that were taken from different 
starting positions. 

• To rotate or flip a profile recording plot the recordings in the 
Chart or Radial page. 

• Click Rotate. The Rotate & Flip window will be displayed. 

• Select the recording to be manipulated. 

• Perform the required change by clicking the associated 
button to perform the manipulation required. 

If a recording was performed with the sensor clamped in an opposite 
direction to previous recordings, clicking the Flip button will flip the 
selected recording so it matches the other recordings. 
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Alarms 

Setting up Alarms 

Profiler MAS can check your commutator and slip ring recordings for 
the following alarm conditions: 

Total Indicated Runout (TIR) – the difference between the 
highest and lowest points on the profile. 

Maximum Bar-to-Bar (MBTB) – the difference in height 
between adjacent commutator bars. 

Maximum Segment to Segment (MSTS) – the difference in 
height between adjacent Slip Ring segments. Note that a 
segment is simply a lineal distance equal to 4 mm ± 0.5 mm 
(160 ± 20) mil. 

High Mica – lists any Mica insulators (between commutator 
bars) which are not recessed below the bar surface. 

To edit the alarm settings 

• On the 'Info' page click Edit in the 'Alarms Settings' section. 
You must have commutator or slip ring recording(s) selected 
to display the 'Alarms Settings' on the 'Info' page. 

The setting values of the alarms can be edited for the selected 
recording(s). 

MBTB and MSTS alarms have a Range setting. The default value of 
1 means that adjacent bars or segments are compared. You can 
increase the value if you want to perform the check over a wider 
group of bars or segments. 

• To set up a default set of alarms for your recordings click 
Edit Defaults. 

Notes 
If you check the 'Apply these defaults to future recordings' box, these 
alarm settings will be applied to all profile recordings received from 
the instrument. 
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You can also Save and Load various previous alarm settings using 
the Save and Load buttons. 

 

Checking Alarms 

The icon for each recording in the navigator will change color to red if 
the recording has generated one or more alarms. This will only occur 
if Enable Auto Alarms has been set. 

• To enable Auto Alarms select Tools>Auto Alarms. 
Alternatively click the toolbar Alarms button and select 
'Enable Auto Alarms'.  

• To check the alarms for recordings select the recording(s) 
you wish to check. 

• On the toolbar click Alarms to display the list of alarms that 
have been triggered by the recording(s). 

• To obtain more information about each alarm condition, click 
on its button. This will display a detailed report about the 
recording that can be printed or copied to the clipboard and 
pasted into another application. 
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Upgrading Firmware Using PROFLASH 
When an upgraded instrument firmware version is available it will be 
posted on the Commtest Instruments Ltd website 
www.commtest.com under Downloads>Profiler. Once you have 
obtained the firmware file the firmware can be upgraded using the 

PROFLASH procedure below. 

Warning: Upgrading the firmware erases all data in the instrument. 

• With the instrument powered on, connect and turn on the 
battery charger. 

• Connect the RS232 port of the instrument to the configured 
PC COM port using the data-transfer cable. 

• Transfer any data you wish to keep to the MAS software. 

• In the MAS software click Tools>PROFLASH Profiler. 

• In the PROFLASH window click PROFLASH then Automatic 

search. 
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• Click the drop-down box Select Drive to Search and select 
the drive where the new firmware version is located. 

• Click Start Search and when the search is completed select 
the new firmware file. 

• Click Start Proflash using this file. 

Once the reprogramming is complete the instrument will beep and 
the Initialization screen will appear. If an error occurs, check that the 
data-transfer cable has been connected properly and that the 
instrument is powered on. 
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Appendix A: Specifications 

The following are the specifications for: 

• Instrument firmware version 1.53 

• Profiler MAS software version 5.00 

These specifications may be changed in future versions. 
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Specifications 
Model PRTC 

 Profiling - Temperature - 
Current 

Remarks 

Range 
Displacement
Temperature

Current

 
± 16 mil (± 400 µm) 
14 °F to 1830 °F (-10 to 1000) °C 
0 amp to 1000 amp DC 

 
Imperial / Metric is user-selectable 
°F / °C is user-selectable, K-type thermocouple 
with optional current probe 

Resolution 
Displacement
Temperature

Current

 
0.04 mil (1 µm) 
0.1 °F (0.1 °C) 
1 amp 

 

Accuracy 
 

Displacement
Temperature

Current

 
 
± 2% ± 0.16 mil (4 µm) 
± 1% of reading ± 2 °F (1 °C) 
± 1% of reading ± 1 amp 

 
At ambient Temperature of 73 °F ± 9 °F (23 ± 5) °C 
Battery voltage not less than 6.5 V 
Does not include thermocouple error 
Does not include current probe error 

Sampling Interval 
Displacement

Temperature and Current

 
Maximum recording speed 4 in/s (100 mm/s) 
 
 
 
0.1 seconds to 60 hours 

 
Slip ring segment size 160 mil ± 20 mil (4 ± 0.5) mm 
Recordings taken in 'Shape' mode are sampled at 
20 mil (0.5 mm) across the bar or segment 
 
Selectable in steps of 0.1 second, 1 second, 1 
minute, or 1 hour 

Memory 
Data Storage

Capacity

Data Set Name

 
Up to 50 named Data Sets 
Up to 50 recordings per Data Set 
Up to 9999 samples per recording 
 
 
512 kilobytes – approximately 100 000 
individual samples 
 
Up to 16 alphanumeric characters 

 
 
Each recording has unique time/date stamp. 
Total number of samples depends on the number of 
Data Sets 
 
Non-volatile memory (battery backup). Number of 
samples depends on the number of recordings and 
the variability of the readings 
 

Display 

Resolution
Viewing area

Backlight 

 
Graphic LCD 
240 x 128 pixels 
4.3" x 2.3" (110 x 60) mm 
Electro-luminescent 

 
 

PROFLASHPROFLASHPROFLASHPROFLASH  
Allows internal firmware to be upgraded via 
built-in serial port 

 
Download firmware service packs via the Internet 
 

Communications 
Baud rate

RS232 
9600, 19 200, 57 600 bits per second 

15 kV ESD protected. Cable with DB9 connector 
Automatic baud rate selection 

Termination 
Displacement
Temperature

Current
Communications

 
8 pin round plug 
Socket accepts miniature thermocouple with 
twin blade 
BNC Connector 
5 pin round plug 

 
 
 
Blades spaced 5/16" (7.9 mm) center-to-center 

Battery 
Type

Voltage
Capacity

Operating time (typical)

 
Custom Nickel-Cadmium pack 
7.2 V nominal 
1500 mAh nominal 
13 hours nominal with backlight off 
7 hours nominal with backlight on  

 
 
 

Charger and Conditioner 

Fast Charge rate
Discharge rate

 
Built-in dual rate charger – automatic and 
manual control 
0.7 A nominal 
0.5 A nominal 

 
Power transformer with 13.5 V ± 1.5 V DC, 1 A 
output included in kit 
2.5 hours for complete charge nominal 
Combats NiCad battery memory effect 

Mechanical 
Size

Weight

 
9.7" W x 6.1" L x 3.0" H (247 x 154 x 75) mm 
4.4 lb (2 kg) 

 
Including protective boot 
Including protective boot and strap 

Environmental 
Temperature/Humidity

Operating

Storage

EMC

 
 
32 °F to 122 °F (0 to 50) °C  
 80% RH 32 °F to 86 °F 
 70% RH 86 °F to 122 °F 
14 °F to 140 °F (-10 to 60) °C  
 95% RH 
EN50081-1 
EN50082-1 

 
 
 
Non-condensing 
Non-condensing 
 
 
Radiated and conducted emissions 
RF field, ESD and fast transient immunity 

Revised 2001. While every effort has been made to provide the most accurate information we advise that information in this document 
may contain technical inaccuracies or typographical errors. Commtest Instruments Ltd may at any time and without notice make 
improvements and/or changes in the product described in this information. 
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Appendix B: Profiler MAS Math 

The following are the mathematical functions and operators that can 
be used in Profiler MAS-3000 calculations. 

The symbols A, B, C… represent channel tags; and L1, L2 … Ln 
represent logical expressions (e.g. int(A) > 3). 

The notation used for functions and operators is similar to that used 
in common computer-programming languages and spreadsheet 
programs. 
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Functions 

Mathematical Functions 

Function Meaning 

Abs(A) Absolute value 

Cos(A) Cosine 

Deg(A) Convert from radians to degrees 

DegC_to_DegF(A) Converts Celsius to Fahrenheit 

DegF_to_DegC(A) Converts Fahrenheit to Celsius 

Exp1 Base of natural logarithm, e (constant) 

Exp(A) Exponent 

Frac(A) Fractional part 

Int(A) Integer part 

Ln(A) Natural logarithm 

Log(A) Base-10 logarithm 

Max(A, B, … ) Return the maximum value 

Min(A, B, … ) Return the minimum value 

N Sample number (starting from zero) 

Pi π (constant) 

Power(base, 
power) 

base to the power of power e.g. 
Pow(A,3) gives A

3
 

Pow(3,k1) 
Pow(A,B) 

Rad(A) Convert from degrees to radians 

Round(A) Rounded value 

Sgn(A) Sign (-1 if negative; +1 if positive; 0 if zero) 

Sin(A) Sine 
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Function Meaning 

Sqr(A) Square 

Sqrt(A) Square root 

Tan(A) Tangent 

ChangePerDay(A) 

ChangePerHrs(A) 

ChangePerMin 

ChangePerSec 

Rate of change (differentiation) 
 
e.g. If channel ‘A’ changes smoothly from 
10 to 25 over a 1 minute period, then 
ChangePerMin(A) will be 15 over that 
period. 

SumOverDays 

SumOverHrs 

SumOverMins 

SumOverSecs 

Summation over time (integration) 
 
e.g. If channel ‘A’ is a 2hr recording with all 
values = 3.5, then SumOverHrs(A) changes 
smoothly from 0 to 7 over the recording. 

 
 

Iterative Functions 

The following iterative functions can be used for constants only. Cell-
level expressions cannot contain iterative functions. 

Function Meaning 

Count(A) Number of samples 

Maxsample(A) Maximum sample value 

Mean(A) Mean 

Minsample(A) Minimum sample value 

Stddev(A) Standard deviation 

Sum(A) Sum 
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Logical Functions 

Function Meaning 

AND(L1, L2, …, Ln) Logical AND e.g.  
AND(n = 10, k2 > 0.5, k3 > 0.5, k2 <> k3) 

False Logical constant, has value 0 

OR(L1, L2, …, Ln) Logical OR e.g. 
OR(k0 = True, k1 < 3, n >= 30) 

True Logical constant, has value 1 

AOR(L1, L2, …, Ln) Logical AOR (exclusive OR) e.g. 
AOR(k0 = True, k1 < 3, n >= 30) 

NOT(L1, L2, …, Ln) Logical NOT e.g. 
NOT(k1 =True, k2 < 10, n> 30) 

 
 

Conditional Functions 

Function Meaning 

IF(L1, true result, false result) If logical expression L1 is true, 
execute true result, otherwise 
execute false result e.g. 

IF(k2 > k3, k2*A, k3*A) 

IF(k0 = True, n, n*2) 

IF(n < 10, n, Log(n)) 
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Date and Time Functions 

In profiler MAS the date and time value when a sample is taken is a 
floating-point number. The integer part of the number represents the 
date: this is the number of days since the first day of 1 AD. The 
fractional part of the number represents the time: this is the 
proportion of time that has passed since the beginning of the day. 

Function Meaning 

Date(year, month, day) Return the date in profiler MAS 
format e.g. 

Date(1999, 07, 25) 

Time(hour, minute, second, 
ms) 

Return the time in profiler MAS 
format e.g. 

Time(16, 59, 31, 965) 

Elapsed(sample number) Return the date and time of the 
sample in profiler MAS format 
e.g. 

DAT(36) 

SampleDate(n) Date of the nth sample 

SampleTime(n) Time of the nth sample 
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Operators 

Logical Operators 

Operator Meaning 

< Less than 

<= Less than or equal to 

<> Not equal to 

= Equal to 

>= Greater than or equal to 

> Greater than 

 
 

Arithmetic Operators 

Operator Meaning 

+ Addition 

– Subtraction 

/ Division 

* Multiplication 

 
Profiler MAS uses the standard arithmetic order of precedence i.e. 
division and multiplication take precendence over addition and 
subtraction. An operand between two operators of different 
precedence is bound to the operator with higher precedence. An 
operand between two equal operators is bound to the one on its left. 
Expressions within parentheses are evaluated before being treated 
as a single operand. 

 


